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8. Rating an order 

Although charges for an order are not finalized until the order is invoiced, you can pre-rate an 
order during the order entry process. To rate an order, you can: 

 Specify the line haul charge.  

 Record accessorial charges.  

Information is provided on these pages: 
 

Understanding the rating process ......................................................................................................................... 8.2 
What is a charge type? ..................................................................................................................................... 8.2 
Types of billing rates ........................................................................................................................................ 8.3 
How billing rates are applied ......................................................................................................................... 8.4 

Determining an order's line haul charge .............................................................................................................. 8.6 
Rating an order in Rate by Total mode .......................................................................................................... 8.6 

Entering the line haul charge manually ................................................................................................. 8.6 
Basic steps ............................................................................................................................................ 8.6 
Locking in rating information entered for an order ...................................................................... 8.7 

Fixing a charge quantity so that is not overwritten by the actual quantity ................... 8.7 
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Understanding the rating process 

Some companies base rating decisions entirely on pre-existing, negotiated contracts. Other 
companies negotiate rates with customers as orders are entered. Still other companies employ 
the first rating method with some customers and the second rating method with other 
customers. 

To pre-rate an order, you must understand the rating options that TMWSuite offers: 

 Automatic calculation of line haul and/or accessorial charges 

When you use the Compute command to have the system calculate charges, it searches 
through billing rates you set up in the Rate Schedules application. If it finds appropriate 
match(es), it applies charges based on the rate(s) found.     

 Manual entry of line haul and/or accessorial charges 

You can record charges manually if: 

 You do not have a pre-existing, negotiated contract with a customer. 

or 

 You have a pre-existing contract, but you choose to override it with rates negotiated on 
the fly for a specific order. 

In some cases, an order entry representative will use both rating options for the same order. For 
example, he/she can use the Compute command to have the system automatically assign the 
line haul charge and some accessorial charges. In addition, he/she can manually add other 
accessorials to the order. 

Orders can be pre-rated in Order Entry and in Dispatch. The rates assigned in either of those 
applications can be retained or changed when invoices for orders are created in the Invoicing 
application.  

What is a charge type? 

Charge types must be defined before you can rate an order either manually or automatically. A 
charge type is an item for which a customer may be billed. It identifies the unit of measure used 
to calculate the charge. For example, if you charge by the mile, the rate is mileage-based. If you 
charge according to weight, the rate is weight-based.  

Charge types are categorized as primary or secondary. A primary charge type is used for a line 
haul charge, i.e., the base amount the customer is to pay for the transportation of a load. A 
secondary charge type is used for any accessorial charge that is billed separately from the line 
haul cost.  

Some charge types are a standard part of TMWSuite and come pre-loaded with the system. 
These are called system codes. Charge types that are system codes for line haul charges are 
listed here: 
 

Charge Type Use 

Freight (Distance) Line haul rates based on cents per mile for all miles traveled between 
billable stops. 
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Charge Type Use 

Freight (Dist O-D) Line haul rates based on cents per mile for miles between origin and 
destination. 

Note:  Miles traveled for interim stops are not considered. 

Freight (Weight) Line haul rates based on cents per hundred weight. 

Freight (Flat) Line haul rates based on flat dollar amounts. 

Freight (Count) Line haul rates based on cents per piece, i.e., boxes, bushels, etc. 

Freight (Volume) Line haul rates based on cents per gallon. 

Freight (Time) Line haul rates based on dollars per hour. 

Freight (Default) Not to be used on any rates; used as the system default for the line 
haul charge type on an order that has not yet been rated 

Most accessorial charge types do not come preloaded in the system, i.e., few system codes exist 
for accessorial charge types. For the most part, your company must create its own accessorial 
charge types. Commonly used accessorials are listed here: 

 Stop Charge 

 Cleaning 

 Hand Loading 

 Hand Unloading 

 Fuel Surcharge 

Note: Charge types are set up in the Enter/Edit Charge Types window. You can access this 
window in the Rate Schedules application or in the Invoicing application. 
 

Types of billing rates 

Before you can use the Compute command to have the system rate a load automatically, billing 
rates must be set up in the Rate Schedules application. There are four types of rates: 

 Primary rates 

Primary rates are used for line haul (freight) charges 

 Secondary rates 

Secondary rates are used for accessorial charges that can be predicted. Secondary rates must 
be linked to a primary rate. When a primary rate is applied to an order, the system checks to 
see whether any attached secondary rates match the order. If they do, the secondary rates 
are applied. 
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 Line item rates 

Line item rates are used for accessorial charges that are applied on an as needed basis. In 
other words, line item rates represent accessorial charges that cannot be predicted in 
advance, such as detention time. Unlike secondary rates, line item rates are not linked to 
primary rates. Line item rates are applied only when an accessorial charge is manually 
added to an order. 

 Linked line item rates 

A linked line item rate can be thought of as a hybrid between secondary and line item rates 
because it has properties of both: 

 Like a secondary rate, it must be linked to a primary rate. 

 Like a line item rate, it is applied only when an invoice detail (line item) with a $.00 
amount is manually added to an order. 

How billing rates are applied 

Once rates are created in the Rate Schedules application, they can be applied using the 
Compute command in Order Entry, Dispatch, or Invoicing. The system follows this sequence of 
events when determining which rates to use when calculating the charges for an order: 

1. It searches through the primary (line haul) rates you have recorded, checking the order 
against the conditions you have specified for each rate. These conditions are the restriction 
criteria the system uses to determine when the rate should be applied. When it finds a 
primary rate that matches the order, it assigns the applicable line haul charge based on that 
rate. 

2. If secondary (accessorial) rates have been linked to the primary rate, the system compares 
each linked secondary rate to the order. If the order matches the restriction criteria set up for 
a secondary rate, the charge for that rate is applied. 

3. There may be times when a particular accessorial (non-line haul) invoice detail must be 
added because an unforeseen situation warrants it. For example, detention time often 
cannot be predicted; therefore, detention charges are applied on an as needed basis. Such 
situational charges are manually added to an order in Order Entry, Dispatch, or Invoicing. If 
an accessorial line item is added manually and left with a zero dollar amount ($.00), the 
system will do the following:  

a. First it will check for any linked line item rates attached to the primary rate. If it finds 
one that has the same charge type as that used for the accessorial, it applies the linked 
line item rate, assuming the order matches the rate restrictions. The system replaces the 
zero dollar figure with the appropriate charge amount. 

b. If no applicable linked line item rates are found, the system attempts to match the 
accessorial with standard line item rates, i.e., those that are not linked to primary rates. If 
it finds one that has the same charge type as that used for the accessorial, it applies the 
line item rate (assuming the order matches the rate restrictions). The system replaces the 
zero dollar figure with the appropriate charge amount. 
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The diagram below provides an overview of the how the system calculates charges for an order. 
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Determining an order's line haul charge 

The rating method you use, i.e., Rate by Total or Rate by Detail, determines the steps you must 
follow to apply the line haul charge to an order. 

Rating an order in Rate by Total mode 

When you use Rate by Total mode, the rate is based on a sum total, such as weight or mileage, 
for all stops. Individual freight details cannot be rated separately, so the charge for an order is 
not determined by individual freight details.  

Entering the line haul charge manually  

When you use Rate by Total mode, you must record the appropriate rating-related entries in the 
order header. Applicable fields are shown here: 

 

When you record a line haul amount manually, these fields are always used: 

 Charge Item (Charge Type) 

 Chrg Qty 

 Rate Unit (display only) 

 Rate 

 Linehaul Chrg (display only) 

These fields are used if the occasion warrants it: 

 Actual Qty and Actual Unit 

 Fix (located to the right of the Chrg Qty field) 

 Fix check box 

 Fix Chrgs LH and All check boxes 

Basic steps 

1. In the Order Entry Folder, create/look up the order to be rated.  

2. If the order will be rated based on weight, volume, or count, enter the appropriate quantity 
in the Actual Qty and Actual Unit fields in the order header. 

Notes:  

1. The system automatically copies the entry recorded in the Actual Qty field to the Chrg 

Qty field. 

2. If the order will be rated based on miles, there is no need to enter the mileage amount in 
the Actual Qty and Actual Unit fields. The system determines the mileage amount for 
you. 
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3. Click in the Charge Item field. Select the desired charge type from the drop-down list. The 
system fills in the Rate Unit field based on the charge type you select. 

 

Charge Item selection determines the Rate Unit 

4. The Chrg Qty field identifies the number of units by which the rate is to be calculated. The 
entry in this field reflects the entry made in the Actual Qty field.   

Leave the quantity as is.  

Note: If you chose Freight (Distance) or Freight (O-D) in the Charge Item field, the system 
automatically fills in the Chrg Qty with the mileage amount.  

5. In the Rate field, enter the per unit dollar amount.  

Note: As you tab from the Rate field, the system calculates the line haul charge and displays 
the total in the Linehaul Chrg field. The line haul charge is also shown in the top right 
corner of the order header.  

 

Line haul charge 

6. Click the Save  icon in the sheet toolbar. 

Locking in rating information entered for an order 

You may occasionally want to protect rating information from being changed by other users 
who access the order in other applications. The following sections describe the various ways 
you can protect the rating information you entered from changes.  

Fixing a charge quantity so that is not overwritten by the actual quantity 

There may be times when you want to assign a charge quantity that is different than the 
quantity that the system determines is the correct amount. This need commonly occurs with 
orders that are rated based on miles. Additionally, you may need to do this with orders based 
on weight, volume, or count.  

For example, the system determines actual miles based on the mileage amount returned by your 
mileage interface. However, for a specific order, you may want to rate an order based on a fixed 
mileage amount that you and your customer have negotiated. This fixed amount may affect 
billing and (if the driver is paid by the mile) settlement of the order. 

The Fix field in the order header lets you specify that the charge quantity entered in Order 
Entry should not be automatically reset to the actual quantity in the Invoicing and (if 
applicable) Settlements applications. 
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This allows you to charge the customer, or pay the resource, for a quantity other than the actual 
amount. 

 

The Fix field provides these options: 

 Not Fixed 

The quantity is not fixed. As a result, the actual quantity recorded for the trip will be used 
(the default).  

 Inv Only 

The quantity is fixed and should be retained when the order is invoiced. 

 Inv & Stl 

The quantity is fixed and should be retained both when the order is invoiced and when the 
resource is paid for the trip. 

Note:  This option is applicable when both the billing rate and the pay rate have the same 
basis. For example, both rates are based on weight, or on volume, or on miles, and so on. 

For instance, suppose the actual distance for an order is 61 miles, but you negotiate a billing rate 
based on a mileage amount of 75. To fix the billing quantity, you must do the following in the 
order header: 

1. Select Freight (Distance) in the Charge Item field. 

2. Enter 75 in the Charge Qty field. 

3. Select Inv Only from the drop-down list in the Fix field.  

This prevents the system from resetting the charge quantity to 61. The quantity of 75 is retained 
even if an applicable mileage-based rate has been set up in the Rate Schedules application and 
you use the Compute command to have the system apply the rate. If you leave the Not Fixed 
option selected, when the Compute command is used the quantity will be reset to the actual 
distance for the distance-based rate. The same would hold true for weight, volume, or count. 

Note: If you use the Inv & Stl option to ensure that a fixed mileage will be used when the 
resource is paid, be aware of the following: 

 The fixed quantity will be applied for loaded miles only. 

 When mileage-based rates are applied, the system normally creates a pay detail for each 
individual leg; the pay detail indicates the miles traveled for the leg as well as the applicable 
per-mile amount. When the Inv & Stl option is used, individual loaded legs will not be 
listed. Instead, a single pay detail will be created for all loaded miles. The pay detail will list 
the fixed quantity you specified in the order header. 

 If empty miles exist for the trip, the system will compute pay for empty legs as it always does. 
(For this reason, the Inv & Stl option works best for trips that do not involve empty legs.) 
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The DefaultFixQty setting in the [Order] section of the TTS50.ini file lets you specify the 
option that will serve as the default for the Fix field: 

 

[Order] 

DefaultFixedQty 

Applies to TMWSuite 

Description This setting specifies which option will be set as the default in the Fix Quantity 
field drop-down list in the order header. 

Options  0 (default) 

Use Not Fixed as the default. 

Note:  When this option is used, the text displayed in the Fix Quantity field 
in the Order Entry application is Not Fixed; the text displayed in the Fix 

Quantity field in the Dispatch Trip Folder is None. 

  1 

Use Inv Only as the default. 

  2 

Use Inv & Stl as the default. 
 

Freezing the rate per unit 

You can freeze the rate (the per unit dollar amount) when you pre-rate an order. You use the Fix 

check box to tell the system that the per unit dollar amount is to remain the same. You can 
freeze the rate on orders that are prerated manually, or on those that were pre-rated using the 
Compute command. When the order is invoiced, the rate remains the same.  
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In the Invoicing application, you can override the Fix Rate setting on a prerated order by 
clearing the check box. 

 

If you use the Orders Ready to Prepare queue to process prerated orders, the system will not re-
rate an order with a fixed rate. For such an order, the Batch Error Log displays a "Charge fixed 
in OE" message for orders that have the Fix check box selected. The fixed rate is retained when 
the invoice is saved. 

 

Note: The Batch Error Log also shows this message for orders that have the Fix Chrgs LH or 
ALL check boxes selected  
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Freezing line haul only, or all charges, on prerated orders 

The order header contains separate check boxes for freezing line haul and all charges.  

 

Fix Chrgs check boxes in Order Entry  

 

Fix Chrgs check boxes in Trip Folder 
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Freezing only the line haul charges 

Selecting the LH check box forces the system to retain the line haul charges on a prerated order 
during the invoicing process. The order can be re-rated using the Invoices Ready to Prepare 
queue or the Compute command in the Edit Invoice Folder. However, only the accessorial 
charges will be re-rated.  

This illustration shows how a prerated order that has its line haul charge fixed is displayed in 
the Edit Invoice Folder. The invoice header shows the FixChrg LH check box selected. 

 

Note the invoice detail line for the line haul charge. Its Quantity and Rate fields cannot be 
edited. Its Fix$ check box is selected. 

Even if your TTS50 file contains the OverridePreRatingInQueueProcessing=Yes setting 
in the [Invoice] section, a check mark in the Fix Chrgs LH check box overrides the setting. 
The check mark prevents re-rating of the line haul in the Orders Ready to Prepare queue. If you 
need to rerate the line haul charges, you must clear the LH check boxes.  

Note: Whether you clear the check box in the invoice header or the detail line, the system also 
clears the other check box. 
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Freezing all charges 

Selecting the All check box forces the system to retain the line haul and accessorial charges on a 
prerated order during the invoicing process.  

Notes:  

1. When the All check box is selected, the system automatically selects the LH check box as 
well. 

 

2. When the All check box is selected, the Fix check box for each accessorial in the Accessorials 
and Secondary Charges window is also selected. 

 

3. The Fix check box in the Accessorial and Secondary Charges window will not override the 
selection of the All check box in the order header. Also, if the All check box is not selected, 
you cannot independently freeze an accessorial charge using its Fix check box. 

 

The order cannot be re-rated using the Invoices Ready to Prepare queue or the Compute 
command in the Edit Invoice Folder.  

Note:  If you attempt to use the Compute command when the Fix Chrgs All check box has a 
check mark, the system displays a message indicating that you cannot compute charges on an 
order for which the charges are fixed. This means that no rates—including accessorial rates—
will be applied. 
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This illustration shows how a prerated order that has all charges fixed is displayed in the Edit 
Invoice Folder. The invoice header shows both the FixChrg LH and All check boxes selected. 

 

Note the detail lines for both the line haul charge and the accessorial charge. Each line has its 
Quantity and Rate fields as display only. Each line has its Fix$ check box selected. 

When the Compute command is used to rerate the order, the system displays this message: 

 

If you rate orders using the Orders Ready to Prepare queue, even if you have the 
OverridePreRatingInQueueProcessing=Yes setting in the [Invoice] section of your 
TTS50.ini file, a check mark in the Fix All check box overrides the setting.  

If you need to re-rate the order after all, you must clear the check mark from the Fix All check 
box. Once the check mark is removed, the order can be re-rated using the Compute command 
or by processing in the order in the Orders Ready to Prepare queue in the Edit Invoice Folder. 
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Letting the system automatically rate an order 

If your company has set up billing rates in the Rate Schedules application, you can have the 
system search through those rates to find one that applies for an order. There are three ways to 
initiate the automatic rating of an order: 

 Click the Compute  icon in the sheet toolbar 

 Select Edit > Compute Charge. 

 Use the shortcut keys, CTRL+G. 

Note:  When you compute the rate for an order, the system will update the Charge Qty with the 
actual quantity, if they are not the same. If you want the Charge Qty to be retained when the 
order is invoiced, select the Inv only option from the Fix drop-down list. If you want to retain 
the quantity when the order is invoiced and when it goes through the settlement process, select 
the Inv & Stl option from the Fix drop-down list. Leaving the Fix field as Not Fixed allows the 
system to override the Charge Qty in the Invoicing and Settlements applications.  
 

How the system applies primary rates in Rate by Total mode 

The system compares the conditions of the order with all billing rates on file. Three scenarios 
can result from this comparison.  

1. An appropriate rate is found and applied.  

If an applicable primary rate is found, it is used to calculate the line haul charge. If 
secondary rates are attached to the primary rate, those charges are included in the 
calculation. The line haul amount is shown in the Linehaul Chrg field. The notation at the 
top right of the order header shows the totals for line haul and accessorial charges.  

 

The primary rate ID is displayed and a note indicates that the rate has accessorial charges linked to it 

2. The order does not match any rates set up for specific Bill To, Parent, or Order By companies.  

If the order does not match any of the line haul rates your company has set up for specific 
Bill To, Parent, or Order By companies, by default the system displays a message indicating 
this. 
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1. For example: 

 

2. Click OK to compare the order with generic rates that do not specify a particular Bill To, 
Parent, or Order By company. If it finds one that matches the order, it applies that rate. If 
none of the generic rates applies, a message similar to the following is shown: 

 

3. The order matches more than one rate.  

If the order matches more than one rate, by default a message indicating this is displayed.  

 

When you click OK, the system displays the Choose Rate window.  

 

Highlight the rate you want applied to the order and click OK.  
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Note: If desired, you can retain the rate applied by prerating to be retained when the order 
goes through the invoicing process. In the order header, select the LH check box, located next to 
the Linehaul Charges field. Then save the order.  
 

How the system applies rating for accessorials in Rate by Total mode 

The system applies rates for accessorial charges in the following order: 

 Secondary 

The customer is always billed for these accessorial charges when a specific primary rate is 
applied to the order.  

Note:  See Scenario 1 in the How the system applies primary rates section. 

 Linked line item 

The customer is billed for these accessorial charges when a $0 accessorial has been added to 
the order in the Accessorial and Secondary Charges window and a specific primary rate is 
applied to the order. 

Note:  For more information on manually adding accessorial charges to an order, refer to the 
Recording accessorial charges for an order section. 

 Line item 

The customer is billed for these accessorial charges when a $0 accessorial has been added to 
the order in the Accessorial and Secondary Charges window. 

Note:  For more information on manually adding accessorial charges to an order, refer to the 
Recording accessorial charges for an order section. 

If the order contains $0 accessorials, three scenarios can result.  

1. An applicable linked line item rate is found  

The applied rate is noted in the Accessorial and Secondary Charges window.  

 

Note:  When accessorials are manually added in the Accessorial and Secondary Charges 
window, the system displays a notation to that effect. In the example shown here, note that 
the system has removed the "Manually added in Order Entry" notation from the $0 
accessorial.  
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2. No applicable linked line item rate is found. 

If no linked line item rate is attached to the applied primary rate, the system will display a 
message similar to the following: 

 

a. If you click on OK, the system will search for an applicable line item rate.  

 If one is found, it will be applied.  

In the example shown here, note that the system replaced the "Manually added in 
Order Entry" notation from the $0 accessorial with "Pre-rated Line Item charge". 

 

 If no applicable line item rate is found, the system displays this message: 

 

Click OK to close the message and complete the rating process. 

When no line item rate is applied, the Accessorial and Secondary Charges window 
still shows the "Manually added in Order Entry" notation and the Charge field still 
shows $0.00. 
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b. If you click on Cancel, the system will display a message similar to this: 

 

Click OK to close the message and let the system complete the rating process.  

When you open the Accessorial and Secondary Charges window, you will see that no 
rate has been applied for the $0 accessorial. 

 

3. Duplicate line item rates are found. 

If duplicate line item rates match the $0 accessorial, a message similar to this is displayed: 

 

If you click OK, the system displays the Choose Rate window 

 

Highlight the rate you want applied to the order and click OK.  

Note:  If desired, you can retain both the line haul rate and the accessorial rate(s) when the 
order goes through the invoicing process. In the order header, select the ALL check box, located 
next to the Linehaul Charges field. Then save the order.  
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Rating an order in Rate by Detail mode 

When you use the Rate by Detail mode, the charge for each freight detail on an order is 
determined separately. Each commodity on an order has its own unique billing rate. When an 
invoice is prepared for that order, the system applies a separate rate for each commodity. The 
total line haul charge is the sum of the freight detail charges.  

Basic steps for manually rating an order 

To manually rate an order, you must enter the freight charge for each commodity in the freight 
detail portion of the Order Entry Folder. 

1. In the Order Entry Folder, look up the order to be rated. 

2. In the Detail View section of the window, be sure that the Commodities radio button is 
selected. 

Each stop for the trip is shown in the lower half of the window. Freight details and charges 
are recorded for stops.  

 

Note:  Although freight detail entries can be made for pickups, these entries are 
informational only. The system does not use them when it totals quantities or freight 
charges. 

In the drop line for the freight detail to be rated, make the appropriate entries in these fields: 

3. Charge Item Select the appropriate charge type from the drop-down list.  

Notes: 

1. The Charge Item options are set up by your company in the Rate 
Schedules application. 

2. Your selection determines the entry in the Rate Unit field, which is 
display only. 

4. Charge Qty 5. Enter the number of units on which the rating is to be calculated. 

Note:  If you entered an amount in the Actual Qty field, the system 
copies that amount into the Charge Qty field. However, if the actual 
quantity transported differs from the charge quantity, make the 
appropriate entry in the Charge Qty field. 

6. Rate  7. Enter the per unit dollar amount. As you tab from the Rate field, the 
system calculates the charge and displays it in the Charge field. 

3. Repeat these steps for each freight detail recorded for the order.  

4. Save you entries. 
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Locking in rating information entered for an order 

You may occasionally want to protect rating information from being changed by other users 
who access the order in other applications. The following sections describe the various ways 
you can freeze rating information on an order. 

Fixing a charge quantity so that is not overwritten by the actual quantity 

There may be times when you want to assign a charge quantity that is different from the actual 
quantity that is transported. This fixed amount may affect billing and, if the driver is paid using 
the same rate unit as the billed charge, settlement of the order. 

The Fix field in the order header lets you specify that the charge quantity entered in Order 
Entry should not be reset to the actual quantity in the Invoicing and (if applicable) Settlements 
applications. This allows you to charge the customer, or pay the resource, for a quantity other 
than the actual amount. 

 

The Fix field provides these options: 

 Not Fixed 

The quantity is not fixed; as a result, the actual quantity recorded for the trip will be used 
(the default)  

 Inv Only 

The quantity is fixed and should be retained when the order is invoiced. 

 Inv & Stl 

The quantity is fixed and should be retained, both when the order is invoiced and when the 
resource is paid for the trip. 

Note:  This option is applicable when both the billing rate and the pay rate have the same 
basis. For example, both rates are based on weight, or on volume, and so on. 

For instance, suppose the actual weight for an order is 41,000 pounds, but you negotiate a 
billing rate based on a quantity of 42,000 pounds. To fix the billing quantity, you must do the 
following in the order header: 

1. Select Freight (Weight) in the Charge Item field. 

2. Enter 42,000 in the Charge Qty field. 

3. Select Inv Only from the drop-down list in the Fix field.  

This prevents someone from resetting the charge quantity to 41,000 pounds. The quantity of 
42,000 is retained even if an applicable weight-based rate has been set up in the Rate Schedules 
application and you use the Compute command to have the system apply the rate. If you leave 
the Not Fixed option selected, when the Compute command is used the quantity will be reset to 
the actual weight for the weight-based rate. The same would hold true for volume- or count-
based rates. 
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Note:  When you are in Rate by Total only mode, the DefaultFixedQty= setting in the 

[Order] section of the TTS50.ini file lets you specify the option that will serve as the default for 
the Fix field. This INI setting is not operational when you are in Rate by Detail/Rate by Total 
mode.  
 

Freezing the rate per unit 

You can freeze the rate (per unit dollar amount) when you pre-rate an order. You use the Fix 

check box to tell the system that the per unit dollar amount is to remain the same. You can 
freeze the rate on orders that are pre-rated manually, or on those that were pre-rated using the 
Compute command. When the order is invoiced, the rate remains the same.  

 

Note: If you attempt to use the Compute command when a check mark exists in the Fix check 
box, a message indicates that you cannot compute charges on an order for which the charges are 
fixed. This means that no rates--including accessorial rates--will be applied. 
 

In the Invoicing application, you can override the Fix Rate setting on a prerated order by 
clearing the check box. 
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If you use the Orders Ready to Prepare queue to process prerated orders, the system will not re-
rate an order with a fixed rate. For such an order, the Batch Error Log displays a "Charge fixed 
in OE" message for orders that have the Fix check box selected. The fixed rate is retained when 
the invoice is saved. 

 

Note: The Batch Error Log also shows this message for orders that have the Fix $ check box 
selected. 
 

Using the Fix$ check box to freeze the charges on an order 

There may be times when you want all charges for an order to stay exactly as they have been 
recorded in Order Entry. In other words, you do not want them to be re-rated later in the 
Invoicing application. The Fix$ check box in any freight detail line allows you to freeze all 
charges on the order.  

A check mark in the Fix$ check box forces the system to retain the line haul and accessorial 
charges on a prerated order during the invoicing process. The order cannot be re-rated by 
means of either the Orders Ready to Prepare queue, or the Compute command in the Edit 
Invoice Folder. 
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The Edit Invoice Folder also contains a Fix$ check box, which is related to the Fix$ check box in 
the Order Entry application. If a check mark is entered in the Fix $ check box on an invoice 
detail line, this forces the system to retain the charges on a prerated order.   

 

If you find you need to re-rate the order after all, you can clear the check mark from the Fix$ 
check box. Once the check mark is removed, the Compute command is enabled. The order then 
can be re-rated, either by clicking Compute in the Edit Invoice Folder, or by processing the 
order in the Orders Ready to Prepare queue. 

Note: Even if the OverridePreRatingInQueueProcessing= setting in the [Invoice] 
section of the TTS50.ini file is set to Yes, a check mark in the Fix$ check box supersedes the 
setting. The check marks prevent re-rating of the order in the Orders Ready to Prepare queue.  
 

Letting the system automatically rate an order 

If your company has set up billing rates in the Rate Schedules application, you can have the 
system search through those rates to find one that applies for an order. There are three ways to 
initiate the automatic rating of an order: 

 Click the Compute  icon in the sheet toolbar 

 Select Edit > Compute Charge. 

 Use the shortcut keys, CTRL+G. 

How the system applies primary rates in Rate by Detail mode 

When it attempts to determine the charge for a freight detail, the system compares the 
conditions of the order with all rates. Four scenarios can result from this comparison.  

1. An appropriate rate is found and applied.  
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If an applicable rate is found, that rate is used to calculate the line haul charge. If secondary 
rates are attached to the primary rate, those charges are included in the calculation. The line 
haul amount is shown in the Charge field.  

 

If a matching rate is found for a freight detail, the system displays the ID of the rate applied, 
as well as the rate quantity used to determine the charge. In this example, different rate 
schedules were found for the two freight details. However, in some cases, the same rate 
schedule may be applied for multiple freight details. 

 The total line haul amount for all freight details is shown at the top of the order header. The 
total for any secondary charges applied is shown there as well.  

 

2. The order does not match any rates set up for specific Bill To, Parent, or Order By companies.  

If the order does not match any of the line haul rates your company has set up for specific Bill 
To, Parent, or Order By companies, a message indicates this. For example: 

 

Click OK if you want the system to compare the order with generic rates, meaning those 
that do not specify a particular Bill To, Parent, or Order By company. If it finds one that 
matches the order, it applies that rate. If none of the generic rates applies, a message similar 
to the following is shown: 
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3. The order matches more than one rate. 

If the order matches more than one rate, a message indicating this is displayed.  

 

When you click OK, the system displays the Choose Rate window.  

 

Highlight the rate you want applied to the order and click OK.  

Note:  If you want the rate you entered to be retained when the order goes through the 
invoicing process, in the order header select the Fix $ check box, located to the right of the 
Charge field for the freight detail. Then save the order.  

Save the order after you apply the appropriate rate.  

4. The applicable rate is based on miles. 

In Rate by Detail mode, you cannot use distance-based rates. If a rate is based on miles, this 
message is shown: 
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Do one of the following: 

 To apply the rate, click Yes. The order automatically switches to Rate by Total mode.  

 

Commodities remains the Detail View type, but Rate Mode switches to Rate by Total. 

 If you do not want to apply the rate after all, click No. 

How the system applies rating for accessorials in Rate by Detail mode 

The system applies rates for accessorial charges in the following order: 

 Secondary 

The customer is always billed for these accessorial charges when a specific primary rate is 
applied to the order.  

Note:  For more information on how secondary rates are applied in Rate by Detail mode, 
refer to these sections of this chapter: 

 Scenario 1 in, How the system applies primary rates in Rate by Detail mode. 

 How secondary rates are applied in Rate by Detail mode. 

 Using the duplicate secondary rate function. 

 Linked line item 

The customer is billed for these accessorial charges when a $0 accessorial has been added to 
the order in the Accessorial and Secondary Charges window and a specific primary rate is 
applied to the order. 

Note:  For more information on manually adding accessorial charges to an order, refer to the 
Recording accessorial charges for an order section. 

 Line item 

The customer is billed for these accessorial charges when a $0 accessorial has been added to 
the order in the Accessorial and Secondary Charges window. 

Note:  For more information about manually adding accessorial charges to an order, refer to the 
Recording accessorial charges for an order section. 
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If the order contains $0 accessorials, three scenarios can result.  

1. An applicable linked line item rate is found. 

The applied rate is noted in the Accessorial and Secondary Charges window. In the example 
shown here, note that the system has removed the "Manually added in Order Entry" 
notation from the $0 accessorial.  

 

2. No applicable linked line item rate is found. 

If no linked line item rate is attached to the applied primary rate, the system will display a 
message similar to the following: 

 

a. If you click on OK, the system will search for an applicable line item rate.  

 If one is found, it will be applied.  

In the example shown here, note that the system replaced the "Manually added in 
Order Entry" notation from the $0 accessorial with "Pre-rated Line Item charge". 

 

 If no applicable line item rate is found, the system displays this message: 

 

Click OK to close the message and complete the rating process. 
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When no line item rate is applied, the Accessorial and Secondary Charges window 
still shows the "Manually added in Order Entry" notation and the Charge field still 
shows $0.00. 

 

b. If you click on Cancel, the system will display a message similar to this: 

 

Click OK to close the message and let the system complete the rating process.  

When you open the Accessorial and Secondary Charges window, you will see that no 
rate has been applied for the $0 accessorial. 

 

3. Duplicate line item rates are found. 

If duplicate line item rates match the $0 accessorial, a message similar to this is displayed: 

 

If you click OK, the system displays the Choose Rate window. 

 

Highlight the rate you want applied to the order and click OK.  
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Switching the rating mode after prerating an order 

If you switch from Rate by Detail to Rate by Total, the system warns that switching rating 
modes will delete the rate. 

For example, you have an order that has been pre-rated in Rate by Detail mode. The line haul 
charges calculated for each commodity are added and shown in the order header: 

 

The line haul charge for each commodity is shown in the appropriate freight detail line. 

When you select the Total radio button in the Rate Mode section of the window, the system 
displays the following warning: 
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If you click Yes, the order display is refreshed. No charges are shown for the order. The total 
line haul charges revert to $0. 

 

If you select the Detail radio button to switch back to Rate by Detail mode, you must use the 
Compute command to rerate the order. 

Note:  If you pre-rate the order in Rate by Total mode and switch to Rate by Detail mode, the 
rate is not deleted. Therefore, the warning is not displayed. 
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Recording accessorial charges for an order 

Accessorial labor charges are fees for labor, unrelated to driving, which is performed by a driver 
during the course of a trip. Examples of accessorial labor include: 

 Loading/unloading detention 

 Fuel surcharge 

 Stop charges 

 Special services performed by your company for its customers.  

Accessorial charges can be added to an order in two ways: 

 They can be assigned manually. 

 They are applied automatically by the system when you use the Compute command. In this 
case, the accessorials are determined by secondary rates that are linked to the primary (line 
haul) rate.  

In Order Entry, you use the Accessorial and Secondary Charges window to look up existing 
accessorials, or to specify that an accessorial charge be added to an order.  

The Accessorial and Secondary Charges window is shown here with sample data. 
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Adding an accessorial charge manually 

To manually add an accessorial charge to an order, follow these steps: 

1. Do one of the following to open the window: 

 Click the Accessorial  icon in the sheet toolbar.  

 Select Edit > Accessorial Charges.  

 Press CTRL+SHIFT+G.  

2. Do one of the following to record an accessorial charge: 

 Click Add to add an accessorial charge to the end of the list. 

 Click Insert to add a new accessorial charge before an existing charge. 

3. Make entries in these fields: 

Charge Item Click in this field for the drop-down list of accessorial charge types 
that have been set up for your company. Select the one that applies.  

Charge Qty Enter the rating quantity that will be used to determine the charge.  

Note: By default, the system automatically displays a value of 1 (one) 
in this field.  

Rate Enter the per unit charge, which the system multiplies by the number 
in the Charge Qty field to determine the total charge for the 
accessorial labor.  

Note:  If a default rate was entered for the charge type at the time it 
was defined, that rate is displayed automatically. Enter the desired 
rate if the default is not correct or is not shown.  

Charge This field shows the dollar figure that results when the system 
multiplies the rate by the quantity to determine the total charge for the 
accessorial labor.  

Commod Enter the unique code that identifies the goods associated with this 
charge. If the accessorial is not associated with a particular 
commodity, leave this field blank.  

Note: Your company defines commodity codes in the commodity 
master file within the File Maintenance application 

Commodity 
Description 

This field is untitled. It displays the commodity name associated with 
the code you entered in the Commod field.  

Loc Company ID for the location where the accessorial labor is to occur 

Location Name This field is read-only. If you entered a company ID in the Loc field, 
this field shows the name and location of that company.  
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Total Accessorial 
Charges 

This field, displayed in the lower middle portion of the window, 
shows the dollar figure that is the sum of all accessorial charges 
recorded for the order.  

When you manually add accessorial charges in Order Entry, the Accessorial and Secondary 
Charges window shows a message to that effect.  

 
Indicates that the charge was added manually in Order Entry 

Applying accessorial charges during the automatic rating process 

When you click the Compute icon to pre-rate an order, the system automatically attempts to 
match the order with the appropriate line haul and accessorial rates.  

How secondary rates are applied in Rate by Total mode 

After the system finds and applies a line haul rate for an order, it checks to see whether any 
secondary rates linked to that rate are applicable. If the order meets the restrictions recorded for 
a secondary rate, the rate is applied automatically. In the Accessorial and Secondary Charges 
window, a message is shown below the charge to indicate that if was added during the 
automatic rating process.  

 
Indicates the charge was added due to application of a secondary rate 

How secondary rates are applied in Rate by Detail mode 

When you use Rate by Detail mode, the line haul charge for each freight detail on an order is 
determined separately. Depending on rate restrictions and order data, one or both of the 
following occurs when an order is rated: 

 The same primary rate applies to multiple freight details. Therefore, it is pulled multiple 
times during the rating process. 

 Different primary rates apply for different freight details on the order. 

Each time a primary rate is applied, the system checks to see if any secondary rates attached to 
it match the order. If they do, they are applied automatically. However, sometimes the same 
secondary rate is attached to multiple primary rates. In other cases the same primary rate is 
applied to multiple freight details. In these situations, the system attempts to apply the same 
secondary rate multiple times.  
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Using the duplicate secondary charge function, you can configure the system to do one of the 
following: 

 Display a message asking whether the first instance of the secondary charge should be 
replaced by the second one. 

 Automatically replace the first secondary charge with the second one. 

 Keep the first secondary charge and apply the additional one. 

The system uses this feature when all the following circumstances apply:  

 The order is being auto rated.  

 Rate by Detail mode is being used. 

 There are multiple commodities on the order.  

 Multiple primary rates apply to the order, or the same primary rate is applied multiple times. 

 The same secondary rate is attached to two or more primary rates, or the same primary rate 
is applied multiple times and it has secondary rate(s) attached. 

Using the duplicate secondary charge function 

To use the duplicate secondary charge function, you must use the 
HandlingOfDuplicateSecondaryCharges= setting in the [Tariff] section of the TTS50.ini 
file. 

[Tariff] 

HandlingOfDuplicateSecondaryCharges 

Applies to TMWSuite 

Description Sometimes when you use the Rate by Detail rating mode, your rate setup may 
cause the system to attempt to apply the same accessorial charge more than once 
for an order. This setting determines how the system will handle duplicate 
secondary charges. 

Options  Ask (default) 

Displays a message asking whether the first secondary charge should be 
replaced by the second one. 

  Replace 

Automatically replaces the first secondary charge with the second one. 

Note: This works well if the secondary charge is based on revenue, because 
the revenue has changed since the last accessorial was created. 

  AddAdditional 

Keep the first secondary charge and apply the second one. 

Warning:  When this option is used, the system will add new accessorial details 
every time the order is re-rated. For example, if the order originally had one 
accessorial and it has been re-rated twice, the order will have three accessorial details 
for the same charge type. 
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The following steps illustrate how this feature is used on a typical order in Order Entry. 

1. Create an order in the Order Entry application using the Rate by Detail mode.  

 

2. Add commodities for which you have set up billing rates. 

3. Click the Compute  icon in the sheet toolbar. After the system applies each primary rate, 
it then applies any matching secondary rates that are linked to that primary rate. If it finds 
duplicate secondary rates it will do one of the following, depending on how the 
HandlingOfDuplicateSecondaryCharges= setting is set:  

a. Ask 

The system displays a message like the following, asking whether the first secondary 
charge should be replaced by the second one.  

 

 Click Yes to have the system replace the existing secondary charge. 

Note: This works well if the secondary charge is based on total line haul revenue, 
because the revenue is more accurate now than it was when the last accessorial was 
created.  

 Click No if you do not want the system to replace the existing secondary charge. 
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b. Replace 

The system automatically replaces the first secondary charge with the second one. No 
message is shown. 

c. AddAdditional 

The system will keep the first secondary charge and apply the second one. 

4. To view the secondary charges, click the Accessorial Charges  icon to open the 
Accessorial and Secondary Charges window. 

 With the HandlingOfDuplicateSecondaryCharges= setting set to either Ask or 
Replace, the system only adds one secondary charge for Hazardous Materials.  

 

 With the setting as HandlingOfDuplicateSecondaryCharges=AddAdditional, 
the system adds two secondary charges for Hazardous Materials.  
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Deleting an accessorial charge from an order 

Accessorial charges can be removed from an order using the Accessorial and Secondary 
Charges window  

1. Do one of the following to open the window: 

 Click the Accessorial  icon in the sheet toolbar.  

 Select Edit > Accessorial Charges.  

 Press CTRL+SHIFT+G.  

2. Position the cursor in any field in the charge line for the accessorial to be deleted.  

3. Click Delete.  

4. A confirmation dialog box displays. 

 Select Yes to delete the accessorial charge. 

 Select No to cancel the deletion. 

Rating a list of orders  

You can pre-rate orders on a one-by-one basis or you can retrieve a group of orders and pre-rate 
them using the Edit > Compute by Queue command. You can also use it to re-rate a group of 
orders that have already been pre-rated. Whether you are pre-rating the orders for the first time, 
or re-rating them, you can preview the charges before you apply them to the orders. 



Rating an order 

 
8.39 Revised: 9/2021 

Order Entry 
 

Retrieving orders for rating 

The Compute by Queue command displays the Batch Rating window, which allows you to 
retrieve a queue, or list, of orders to be rated.  

 

Note:  If your system is configured to use the Rate by Detail rating method, the Batch Rating 
window includes the Rate Mode options. The Detail radio button is selected by default. 

 
 

To limit the list of orders, enter the necessary restrictions in the selection criteria fields. 
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Rate Mode The Rate Mode options display only when your system is set up to use the 
Rate by Detail rating method.  

The system provides two ways to rate orders, Rate by Total and Rate by 
Detail. Rating by total means that the charge for an order is based on a total 
for all stops. The same rating method, such as weight or mileage, applies to 
all stops. Rating by detail means that the charge for each freight detail on an 
order is determined separately from the others, i.e., each commodity on an 
order has its own unique rate. 

Select the appropriate radio button, Total or Detail, for the rating method 
used for the orders you want to retrieve. 

Note:  If your system is configured for the Rate by Detail rating method, the 
Detail radio button is selected by default when you first open the Batch 
Rating window, or when you click the Reset button. 

Rate Status An order is considered rated if it has a line haul charge that is greater than zero. 
That charge may be the result of auto-rating, i.e., the system has compared the 
order with established rates and selected one that is applicable. The line haul 
charge may also be the result of manual rating, i.e., a user has manually entered 
the charge, in which case, no rate is associated with the order.  

Select the appropriate radio button to specify the rating status of the orders 
you want to retrieve.  

 Not Rated 

Limit the retrieval to orders that match the rest of the criteria and for 
which no line haul charge exists 

Note:  If this option is selected, the tariff fields (Tariff #, Tariff ID, Tariff 
Item) are not available. 

 Rated 

Limit the retrieval to orders that match the rest of the criteria and for 
which a line haul charge exists 

Note:  If this option is selected but you leave the tariff fields (Tariff #, 
Tariff ID, Tariff Item) blank, all rated orders matching the rest of the 
criteria will be retrieved, whether they were rated manually or using 
auto-rating. 

 All 

Retrieve orders that match the rest of the selection criteria and ignore their 
rating status. 

Notes:   

1. If this option is selected but you leave the tariff fields (Tariff #, Tariff 
ID, Tariff Item) blank, all orders, both rated and unrated, will be 
retrieved. 

2. By default, the All radio button is selected when you first open the 
Batch Rating window, or when you click the Reset button. 
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Bill To To retrieve orders for a specific customer, select the required company ID 
from the drop-down list. 

Booked Date Two text boxes are provided for you to enter a date range for the booked date 
on the orders you want to retrieve. The booked date on an order may be 
helpful in selecting orders processed within a certain period. The booked date 
is the date the order was submitted by the customer.  

 

Enter the beginning date/time of the range in the first field; enter the ending 
date/time of the range in the second field. 

Ship Date Two text boxes are provided for you to enter a date range for the ship date on 
the orders you want to retrieve. The ship date is the date the pickup was 
made at the shipper's location. 

 

Enter the beginning date/time of the range in the first field; enter the ending 
date/time of the range in the second field. 

Inv Efft Date Not functional 

Order Status Use the drop-down list to select the status of the orders for which you want to 
search. The options are: 

 Live orders, not invoiced 

Retrieve orders that match the rest of the selection criteria and have a 
status of Available, Planned, Dispatched, Started, or Completed. 

 Master Orders 

Retrieve orders that match the rest of the selection criteria and have a 
status of Master. 

Note:  A master order is an order template from which future orders can 
be copied 

 Quotes 

Retrieve orders that match the rest of the selection criteria and have a 
status of Quote. 

 Pending or tendered 

Retrieve orders that match the rest of the selection criteria and have a 
status of Pending or Tendered. 

Order Number 
Range 

Use the Lowest and Highest fields to set a range of order numbers. 
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Tariff # This field is available only when the Rated or the All radio button is selected. 

You can search for orders for which the system has used a specific primary 
rate to calculate charges.  

Use the text box to enter the Rate # of the rate by which orders have been 
rated. For example, if you need to re-rate orders for which charges were 
calculated using a now expired rate, you would enter that rate's system-
assigned numeric ID in the text box.  

 

Rate # is assigned by the system 

Note:  If you specify the Tariff #, the Tariff ID and Item are not needed; the 
system makes their fields unavailable.  

Tariff ID This field is available only when the Rated or the All radio button is selected. 

You can search for orders for which the system has used a specific primary 
rate to calculate charges.  

Use the text box to enter the Rate ID of the rate by which orders have been 
rated. For example, if you need to re-rate orders for which charges were 
calculated using a now expired rate, you would enter that rate's user-assigned 
ID in the text box. 

 

Rate ID is user-assigned 

Note: If you specify the Tariff ID, be sure to enter it exactly as it was recorded 
in the Edit Billing Rate Folder. You may also enter the Tariff Item if desired. 
The Tariff # is not needed; the system makes its field unavailable. 

Tariff Item This field is available only when the Rated or the All radio button is selected. 

You can search for orders for which the system has used a specific primary 
rate to calculate the line haul charge.  

Use the text box to enter the Rate Item of the rate by which orders have been 
rated. For example, if you need to re-rate orders for which charges were 
calculated using a now expired rate, you would enter that rate's user-assigned 
description in the text box. 

 

Rate Item is user-assigned 

Note: If you specify the Tariff Item, be sure to enter it exactly as it was 
recorded in the Edit Billing Rate Folder. You may also enter the Tariff ID if 
desired. The Tariff # is not needed; the system makes its field unavailable. 
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Parent ID First available in 2021.1 

To retrieve orders for a specific Parent company, select the company ID from 
the drop-down list. 

Note: In the Company profile, you designate a company as a parent 
company. Then, you may link multiple subcompanies or divisions to that 
parent company. Setting up a parent and divisions is useful when billing rates 
for subcompanies are based on the parent. 

RevType1 This restriction corresponds to the RevType1 field in the order header. 

Use the drop-down list to limit the retrieval to orders that match all other 
criteria and that have this value in the order header RevType1 field. 

Note:  The name and options for this field are user-defined, using the 
RevType1 label in the System Administration application. 

RevType2 This restriction corresponds to the RevType2 field in the order header. 

Use the drop-down list to limit the retrieval to orders that match all other 
criteria and that have this value in the order header RevType2 field. 

Note:  The name and options for this field are user-defined, using the 
RevType2 label in the System Administration application. 

RevType3 This restriction corresponds to the RevType3 field in the order header. 

Use the drop-down list to limit the retrieval to orders that match all other 
criteria and that have this value in the order header RevType3 field. 

Note:  The name and options for this field are user-defined, using the 
RevType3 label in the System Administration application. 

RevType4 This restriction corresponds to the RevType4 field in the order header. 

Use the drop-down list to limit the retrieval to orders that match all other 
criteria and that have this value in the order header RevType4 field. 

Note:  The name and options for this field are user-defined, using the 
RevType4 label in the System Administration application. 
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When all desired restrictions have been set, click the Retrieve button, located in the window's 
lower left corner. The bottom half of the window displays a list of all orders matching your 
restrictions. 

 

Data for the orders is displayed in the following columns: 

Order # The system-assigned ID given to the order the first time it was saved. 

Ship Date The date the pickup was made at the shipper's location. 

Bill To The ID and name of the company responsible for payment of the 
charges for the order. 

City The city/state/county location of the company responsible for 
payment of the charges for the order. 

Ord Status The status of the order. 

Total Charge The total line haul and accessorial charges on the order. 

Tar Number The system-assigned ID of the rate used to calculate the charges on the 
order. 

Note:  Only one rate is displayed for each order. Since the system 
could use multiple rates to calculate charges for an order rated by 
detail, this field displays a 0 (zero) as the rate number when you select 
Detail as the rate mode. 

Tariff ID The user-assigned ID of the rate used to calculate the charges on the 
order. 

Note:  Only one rate is displayed for each order. Since the system 
could use multiple rates to calculate charges for an order rated by 
detail, this field is left blank when you select Detail as the rate mode. 
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Tariff Item The user-assigned description of the rate used to calculate the charges 
on the order. 

Note:  Only one rate is displayed for each order. Since the system 
could use multiple rates to calculate charges for an order rated by 
detail, this field is left blank when you select Detail as the rate mode. 

RevType1 The value in the RevType1 field in the order header. 

Note:  The name and options for this field are user-defined, using the 
RevType1 label in the System Administration application. 

RevType2 The value in the RevType2 field in the order header. 

Note:  The name and options for this field are user-defined, using the 
RevType2 label in the System Administration application. 

RevType3 The value in the RevType3 field in the order header. 

Note:  The name and options for this field are user-defined, using the 
RevType3 label in the System Administration application. 

RevType4 The value in the RevType4 field in the order header. 

Note:  The name and options for this field are user-defined, using the 
RevType4 label in the System Administration application. 

Booked The date the order was entered into the system. 

Line Haul The line haul charge on the order. 

Accessorial Charges The total accessorial charges on the order. 

To change the selection criteria for a new search, click the Reset button. All the fields will return 
to their default settings. 

Rating the list of orders 

There are two options for processing orders in the Batch Rating window: 

 Preview Only 

Rates the orders and displays the changes in the Batch/Error Log. The orders are not 
actually changed. You can use this option to review the charges the rating process would 
compute before you decide to actually make them. 

Note:  If you are re-rating orders, the change in charges for each re-rated order is displayed 
in the Batch/Error Log. 

 Process and Update 

Rates the orders and updates them.  



Rating an order 

 
8.46 Revised: 9/2021 

Order Entry 
 

Either option will temporarily minimize the Order Entry Folder. The message area at the 
bottom of the window displays information about how the queue processing is progressing. 

 

As with all other queue processing, a batch log listing errors and successes is generated.   

 

Notes regarding each order are listed. These notes indicate whether the order was rated/re-
rated successfully. They will show the revised charges resulting from a different rate being 
applied to an order. 

The last entry in the log lists total charges, as well as the total dollar amount that makes up the 
difference between the original total and the revised total. 

 

You can either print a hardcopy of the log or save it to a file. It is recommended that you do one 
of these things so that you have a list of the orders that were rated/re-rated. The list is useful to 
have when you audit the orders for accuracy and completeness. 

Note:  To view/record the batch ID the system has assigned to the log records of orders 
processed in this queue, use the horizontal scroll bar at the bottom of the window to display the 
Batch# column. 
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Reviewing updated orders 

The rated/re-rated orders are placed in the queue. If you wish to review the orders 
individually, you can close the Batch Rating window and use the queue to retrieve the orders. 

Note:  The retrieved orders are placed in the queue, whether you rate/re-rate them or not. If 
you review the orders in the queue before rating/re-rating them, you will be displaying the 
original orders. If you decide to rate/re-rate them, you must retrieve them again.  
 

 To display the queue in a minimized form, click the Show Queue  icon in the sheet 
toolbar or select the View > Queue command. With the queue displayed, you can display 
an order in the Order Entry Folder by clicking on it in the queue. 

Notes: 

1. Both the icon and the command can be used to hide/show the queue. 

2. You can keep the queue window in view as you progress through the remaining orders, 
or you can resize it, if desired. You can also move it by clicking on the window's title bar 
and dragging it to a different spot. 

 To display the orders one at a time, whether the queue is shown or hidden, use the Next  

or Previous  icons in the sheet toolbar. You can also use the Edit > Next in Queue or 
Edit > Previous in Queue commands to display the orders.  
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Updating the start date for master orders 

First available in 2021.1  

Pre-rating a master order allows you to copy the prerated charges to orders created from the 
master order.  

If you pre-rate your master orders, you should: 

 Specify an in effect date range on the rate. For example, 1/01/2022 to 12/31/2022. 

 

 Update the start date on the order each time you negotiate new rates 

Otherwise, the system may keep pulling the old rate, instead of the new one. 

By default, updating an order's start date is a manual process. However, you can set up the 
system so that users can edit a master order's start date when they pre-rate it. You activate the 
feature using the MasterOrderStartDateUpdate General Info Table setting. Enter a value of 
Y in the String1 field. 

Note: When rating an order, the rating engine searches for rates that match the trip. The process 
includes a date verification. The system compares the order's start date to the effective date range 
specified on the rate. If the order's start date does not fall in the rate's effective date range, the 
system rejects the rate. 
 

To update the start date for master orders: 

1. Go to Edit > Compute By Queue. 
The Batch Rating window opens. 

2. In the Order Status field, select Master orders. 

3. Set other restrictions as needed. 

4. Click Retrieve. 
The queue lists the orders that match the restrictions set. 
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5. In the Ship Date field, set the new start date. 

If you are editing the date in the first row of the queue, an Update message appears when 
you tab out of the field. It asks, "Do you want to cascade this order start date to the other 00 
Master orders in the list?" 

 

Note: The Ship Date field is editable only when you have Y set in the String1 field of the 
MasterOrderStartDateUpdate General Info Table setting.  

6. Click Yes to cascade the date or No to update just the first order.  

7. Click Process and Update. 

As the system processes the orders, one or more confirmation messages appear. They ask, 
"Are you sure you want to save this Master Order?"  

8. Select Yes in each message to continue with the update.  
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The system updates the dates on the master orders you edited, and rates or re-rates all the 
orders in the queue.  

When the process is done, the Batch/Error Log is shown. The Message section shows this 
information for each line haul and accessorial charge: 

 The previous total charge and the new total charge 

 Rate ID 

 Charge type ID 

 

9. Click Close to close the Batch/Error Log window.  

10. Click Close to close the queue.  

11. When you close the displayed order, the system shows a message asking, "Do you wish to 
save your changes?" Click Yes. 

 

 


